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NOTES___________________________________________________

Walkabout 5210 is a digital portable dictation machine which has
also been developed as system component within the scope of the
»Walkabout Write« transcriber workstation.
To simplify the revision editing of recordings, the machine has been
provided with new functions, such as the insertion or deletion of text
passages. Using a PC, dictations can be transmitted via a network.

Scope of delivery
– PC software »Walkabout Transfer«
– USB cable
– Batteries 
– MultiMediaCard

(1MB corresponds up to 10 minutes recording capacity)
– Pouch

Accessories
– External microphone: 

any commercial microphone with Ø 3.5 mm jack plug can be
used. The built-in microphone is automatically disconnected.

– External headphone:
any commercial mono or stereo earphone or headset with 
Ø 3.5 mm jack plug can be used.
Impedance: min. 32 Ω.
The volume level at the headphone connector is limited to 
85 dB (A) (with 32 Ω headphone). The built-in loudspeaker is
automatically switched off.

– Power supply unit: Any commercial power supply unit with 
Ø 2.5 mm mono jack plug can be used. 
Please respect the indications about voltage, current and 
polarity:
3 V –- - -  stabilized dc voltage 
0.35 A current

Polarity of the jack plug:        –  +
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NOTES___________________________________________________

In order to assure that this digital portable dictation machine will
be able to provide you with good service and pleasure for a long
time to come, it is important that you observe the following points:

Walkabout 5210
This digital portable dictation machine has been designed for the
recording and playback of voice.
Make absolutely sure that the machine is protected against damp-
ness (rain, water splashes). 
Do not place the dictation machine close to the heating or in direct
sunshine.
The manufacturer will offer no liability for damage resulting from
unauthorized tampering. Open only the cover of the battery com-
partment.
Use only a dry cloth for cleaning. Never use chemical cleaning
agents.

Environmental protection
The batteries – those free of heavy metals too – must not be dis-
posed of in the domestic refuse. Used batteries must be taken to an
old battery collection point at the dealer’s and diposed of properly.

MultiMediaCard
Make absolutely sure that the electrical contacts at the bottom side
of the MultiMediaCard are not exposed to strong mechanical
stress.
The cards are insensitive to dirt and moisture but must nevertheless
be introduced into the machine in dry and proper condition.

Note:
Never remove the MultiMediaCard during recording or
the data transfer from a PC or to a PC. This could result in
the loss of data.

This product complies with the EC regulations »89/336/CEE,
73/23/CEE, 93/68/CEE«.
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THE CONTROL ELEMENTS_______________________

Card slot
On/off button
Socket for external
microphone

Recording button

Slide-switch for recor-
ding, playback, fast 
forward and rewind

Safety lock

Button for new dictation/
escape

Microphone

Recording indicator

Display

Function buttons:
Lettering in bottom 
display row

Up/down button

Menu/OK button

USB interface
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THE CONTROL ELEMENTS _____________________________

HOLD

EAR

3 V
0,35 A

Power supply
socket:
3 V –- - - / 0.35 A
Headphone socket:
imped. 32 Ω min
Card ejection slide-
switch

Battery compartment
cover
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THE DISPLAY__________________________________________

Free memory

Dictation name

Current function

Button lettering

Battery symbol for low
battery/rechargeable
battery. 
Indication for voice
activation and micro-
fone sensitivity
Dictation position, 
total length
Slide-switch position

Free 0:37h VA C
DICTOO1 O:O6

Record Stop
INS NEW
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1 Open the battery compartment. 

2 Insert the batteries (Mignon type, e.g. R6, UM3 or AA, 
2 x 1.5 V). Observe correct polarity. 

Note:
If the batteries are weak, a signal sounds (not when recor-
ding). The battery symbol in the right top corner of the 
display flashes. You can dictate still a few minutes until the
dictation machine switches automatically off.

Mains operation

Note:
If the power supply/charging unit is connected to the dic-
tation machine but not to the mains supply, the machine is
automatically switched off. You need not switch off the 
machine by pulling the mains plug to save the batteries.

Fitting the MultiMediaCard 
Insert the MultiMediaCard into the card compartment with
its skewed side pointing in the direction shown in the dis-
play and at the rear of the dication machine.

Note:
Do not apply force wihen inserting the card. A slight 
pressure is sufficient.

You may use any commercial MultiMediaCards of any
capacity available.

MultiMediaCards must only be formatted via the »For-
mat card« menu function (see chapter »Menu func-
tions – Format Card«).

Formatting as removable disk drive with the PC is not 
correct.

PREPARATIONS________________________________________

STOP

START

PREV.

REW.
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Switching on and off

Switching on the first time
1 Press the »ON/OFF« button until the display is activated.

– The software is loaded.

2 Select the desired display language.

3 Use the up or down button » «  » « to select the
desired  language, e.g. »English«.

4 Press the »OK« button.
– The dictation machine is ready for use.

Subsequent switching on
Press the »ON/OFF« button until the display is activated.

Switching off
Briefly press the »ON/OFF« button.

Safety lock
Push the » « slide-switch up.

Note:
If the safety lock is activated, the message »Keys locked«
appears in the display. If the machine is switched on inad-
vertently (e.g. when carrying it in a pocket), it is switched
off automatically.

SWITCHING THE MACHINE ON _____________

Deutsch
English
Francais

OK
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Dictation

Speak over the dictation machine.
The figure shows the optimum position of the dictation machine.
The high-quality microphone allows also for recordings over
greater distances.

New dictation
1 Press the »NEW« button. A new dictation with the next

higher index number is created.
– If the slide-switch is in the » STOP« position, the red

recording indicator will flash.
– The message »Record Stop« (recording-pause)

appears in the display.

2 Set the slide-switch to » START«.
– The recording indicator is lit permanently.
– The message »Record Start« appears in the display.
– The dictation machine records the dictation.

RECORDING __________________________________________

Free 0:37h
no dictations

MENU NEW
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Recording-pause
Set the slide-switch to » STOP«.
– The recording indicator flashes.
– The message »Record Stop« appears in the display.

Ending the recording
1 Set the slide-switch briefly to » REW.« or » F.FWD«,

or

2 press the red recording button » «.
– »Stop« appears in the display.

Editing a dictation
When playing back a dictation, you may speak a new text
from the current dictation position, or add a recording to the
end of the dictation.

1 Select the desired dictation using the up/down button
»DICT+_«.

2 Set the slide-switch to » STOP« during playback.

3 Press the red recording button » «.
– »Record Stop« appears in the display.

4 Set the slide-switch to » START« and speak the new text.
– »Record Start« appears in the display.

5 Set the slide-switch to » STOP«.

6 Press the red recording button » « or set the slide-switch
to » REW.« or » F.FWD«.
– Recording is stopped.

RECORDING______________________________________________

Free 0:37h
DICTOO1 O:17

Record Stop
INS NEW

Free 0:37h
DICTOO1 O:17

Stop
DICT+- MENU NEW

Free 0:37h
DICTOO1 O:05

Record Stop
INS NEW
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Note:
If the dictation machine has been switched off with the
»ON/OFF« button during the dictation, and then is 
switched on again with the »ON/OFF«  button, the 
dictation will automatically be resumed from its end by
pressing the recording button » «.

Inserting a recording
During playback you can insert a new recording at the 
current dictation position.

1 Set the slide-switch to » STOP« during playback.

2 Press the red recording button » «
– »Record Stop« appears in the display.

3 Press the »INS« button.
– »Insert Stop« appears in the display.

4 Set the slide-switch to » START« and speak the text to be
inserted.
– »Insert Start« appears in the display.

5 Set the slide switch to » STOP«.

6 Press the red recording button » « or set the slide-switch
to » REW.« or » F.FWD«.
– Recording is stopped.

RECORDING______________________________________________

Free 0:37h
DICTOO1 O:14..................[.............................

Insert Stop
NEW
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PLAYING BACK A DICTATION ________________

Selecting a dictation and playing back
1 Select the desired dictation using the up/down button

»DICT+_«.

2 Set the slide-switch to » START«.
– »Start« appears in the display. The dictation is played

back from the beginning.
– At the end of the dictation, »End« appears in the 

display.

Note:
If the dictation machine is switched off with the
»ON/OFF« button, you can resume playback at the pre-
vious position after switching the machine on again with
the »ON/OFF« button.

Fast skip to the beginning or the end of the
dictation

1 Set the slide-switch to » START«.

2 Briefly press the right function button to skip alternately to
the end or the beginning of the dictation.

Volume control
Press the up/down button »VOL +_« during playback.

Fast playback
1 Press the » 1.5 « button during playback.

– The dictation will be played back with about 1.5 times
the normal speed.

2 To return to the normal playback speed, press the 
» 1.0 « button during fast playback.

Free 0:37h
DICTOO1 O:26

Stop
VOL MENU NEW

Free 0:37h
DICTOO1 O:26

Start
VOL 1,5
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DELETING DICTATIONS___________________________

Fast forward and rewind
Set the slide-switch to » REW.« or » F.FWD«.
– »F.Fwd« appears in the display for fast forward,

»Rew« appears for rewind.

DELETING DICTATIONS ______________________

Deleting a dictation
1 Select the desired dictation using the up/down button

»DICT+_«.

2 Press the »MENU« button.
– The first menu function »Delete« appears in the display.
– Use the » « button to select delete.

3 Press the »OK« button.
– »Delete DICT002?« appears, f. ex., in the display.

4 Press the »OK« button.

5 Press the »ESC« button, if you do not wish to delete the
dictation.

Note:
If you wish to delete several dictations, connect the dictation
machine to your PC then use the »Walkabout Transfer«
program to delete the dictations. After deleting all dicta-
tions, the administration data remains on the MultiMedia-
Card. Not the entire memory space on the card then is
available again for recording new dictations.

Free 0:37h
DICTOO1 O:26

Stop
VOL MENU NEW

Free 0:37h
DICTOO1 O:26

F.Fwd
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Deleting a part of a dictation
1 Select the desired dictation using the up/down button

»DICT+_«.

2 Press the »MENU« button.
– »Delete« appears at the top of the menu in the display.

3 Press the »OK« button.

4 Press the »PART« button.

5 Search the beginning of the passage to be deleted using
the playback functions.

6 Press the »MARK1« button.

7 Search the end of the passage to be deleted using the
playback functions.

8 Press the »MARK2« button.

9 Press the »DEL« button.
– »Delete [ ]?« appears in the display.

10 Press the »OK« button.

DELETING DICTATIONS_________________________________

Free 0:37h
DICTOO2 O:14..................[............................

Stop
MARK1 ESC

Free 0:37h
DICTOO2 O:14..................[........]....................

Stop
MARK2 ESC
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The menu
Press the »MENU« button.
You can carry out the following functions:

– Delete Described in the chapter 
»DELETING DICTATIONS«.

– Voice Activ. Automatic interruption of the recor-
ding in the event of speaking pauses
(Voice Activation).

– Mic. sensitivity Adjustment of the microphone sensi-
tivity.

– PC microphone Dictation machine connected as
microphone (without recording) to a
PC sound card. This function is used
for enrolment and direct dictation
using a voice recognition system.

– Power off Automatic or manual switching off
after several minutes.

– Dictation counter Reset dictation counter to zero.
– Version Indication of the machine’s software

version.
– Reset all The reset all is recovered and the

MultiMediaCard is formatted.
– Format card The MultiMediaCard is formatted.
– Language Select a display language.

Use the up/down button » « or » « to mark the desired menu
item. Press the »OK« button to activate the selected menu item.
The current setting is highlighted by a dark background.
Use the up/down button » « or » « to select the setting.
Press the »OK« button to confirm the setting.
Press the »ESC« button to abort the function without changes.

MENU FUNCTIONS ________________________________

Free0:37h
DICTOO1 O:O3

Stop
DICT+- MENU NEW

Delete
Voice Activ.
Mic. sensitivity

OK ESC
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Voice Activation
If the »Voice activ.« function is activated, recording is inter-
rupted when making pauses when speaking. Recording will
be resumed when speaking again.

1 Use the up or down button » «  » « to select the
menu item »Voice activ.«. 

2 Press the »OK« button.

3 Use the up or down button » «  » « to select 
»VA off« or »VA on«.

4 Press the »OK« button.

Microphone sensitivity
If the »Mic. sensitivity« function is switched to conference,
the microphone will record already at low voice levels, e.g.
when it is placed on the conference table.

1 Use the up or down button » «  » « to select the
menu item »Mic. sensitivity«. 

2 Press the »OK« button.

3 Use the up or down button » «  » « to select 
»Dictation« or »Conference«.

4 Press the »OK« button.

MENU FUNCTIONS ________________________________

Delete
Voice activ.
Mic. sensitivity

OK ESC

Delete
Voice activ.
Mic. sensitivity

OK ESC
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PC microphone
With the help of the »PC microphone« you can carry out a
dictation training (enrolment) or make direct dictations using
a voice recognition system. You use the dictation machine as
microphone by connecting the headphones socket of the
machine with the microphone input of the PC’s sound card
using a cable fitted with two 3.5 mm mono jack plugs.

1 Use the up or down button » «  » « to select the
menu item »PC microphone«. 

2 Press the »OK« button.
– »Activate PC microphone?« appears in the display.

3 Press the »OK« button.
– »PC microphone mode« appears in the display.

4 Use the »VOL +_« button to adjust the recording level.

5 To start dictating, press the Start/Stop button » START«
on the dictation machine.

6 Press the Start/Stop button » STOP« again to interrupt
the connection with the PC sound card. In doing so, you
prevent the voice recognition system from recording
disturbing noise.

5 Press the »ESC« button to end the function.

MENU FUNCTIONS ________________________________

Voice activ.
Mic. sensitivity
PC microphone

OK ESC
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Power off
Using the »Power off« function, you can determine whether
the machine switches off automatically after a few minutes, or
must be switched off manually.

1 Use the up or down button » «  » « to select the
menu item »Power off«. 

2 Press the »OK« button.

3 Use the up or down button » «  » « to select »after
10 min« or »manually«.

4 Press the »OK« button.

Dictation counter
Using the »Dictation counter« function, you can reset the
dictation counter. The dictation counter is able to count till
»999«. You should not reset the counter too often to avoid
conflicts with dictations having the same name and being 
stored on the the PC.

1 Use the up or down button » «  » « to select the
menu item »Dictation counter«. 

2 Press the »OK« button.
– »Reset dictate count?« appears in the display.

3 Press the »OK« button.
–  The next new dictation then has the lowest free number

(e.g. DICT005)

MENU FUNCTIONS ________________________________

PC microphone
Power off
Dictation counter

OK ESC

Mic. sensitivity
PC microphone
Power off

OK ESC
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Version
Using the »Version« function, you can display the version of
the machine’s software.

1 Use the up or down button » «  » « to select the
menu item »Version«. 

2 Press the »OK« button.
– The display indicates, for example,

»SW-Version  1.00« – machine’s software.
»# 58144 009033« – abbreviated serial number,
the complete number is to be found on the type plate in
the battery compartment.
»PCB# 00009541« – number of the machine’s 
printed circuit board.

3 Press the »ESC« button.

Note
For information about new software versions, call up
»Configuration« (the button on the left) in the PC soft-
ware »Walkabout Transfer« and select there the func-
tion »Update Server«.

MENU FUNCTIONS ________________________________

Power off
Dictation counter
Version

OK ESC
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Reset all
Using the »Reset all« function, you can restore the factory
settings of the machine.

1 Use the up or down button » «  » « to select the
menu item »Reset all«. 

2 Press the »OK« button.
– The display indicates, for example, 

»Reset settings and all dictations?«.

3 Press the »OK« button.
Factory settings: Voice Activation – off

Microphone sensitivity – Dictation
Power off – after 10 min. 
Dictation counter – DICT001
All dictations are erased.
The card is formatted.
The language option is displayed.

Format card
Using the »Format card« function, you can format a
MultiMediaCard. All dictations are erased.

1 Use the up or down button » «  » « to select the
menu item »Format card«. 

2 Press the »OK« button.
– In the diplay appears, for example, »Format card?«.

3 Press the »OK« button.

Directories and files with administration data are created on
the MMC. For this reason, not the entire memory space is 
available for recording dictations.

Note
It is not allowed to format the MultiMediaCard as remove-
able disk using the format function of a PC.

MENU FUNCTIONS ________________________________

Dictation counter
Version
Reset all

OK ESC

Version
Reset all
Format card

OK ESC
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Language
Using the »Language« function you can select the language
for all display functions.

1 Use the up or down button » «  » « to select the
menu item »Language«. 

2 Press the »OK« button.

3 Use the up or down button » «  » « to select a 
language, e.g. »English«.

4. Press the »OK« button.

MENU FUNCTIONS ________________________________

Reset all
Format card
Language

OK ESC
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Walkabout Transfer
The »Walkabout Transfer« software is used to transfer your dic-
tations to your PC. You obtain an immediate overview of your work
and can also play back your dictations on a notebook. For exam-
ple, transfer your dictations to your transcriber or send Voice Mails
via your mail system.

System requirements for Walkabout Transfer
With USB connector: WIN 98/2000/ME/XP 

With MMC drive,
e.g. at the parallel port:also NT from 4.0 and WIN 95

For e-mail connection: MAPI-compatible mailsystem 
(e.g. Microsoft Outlook)

COMMUNICATION WITH THE PC ___________
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Connecting the dictation machine with the PC
and disconnecting it

1 Connect the dictation machine via the USB interface with
the PC.

2 Use the »ON/OFF« button to switch the dictation machine
on and in PC mode.
– During data transfer the red recording indicator is 

blinking.

Warning: 
Disconnect the USB interface only via the task bar as
otherwise the data transfer may be incomplete.
You should not transfer dictations when the batteries are
low as low batteries distroy the dictation.

Note: 
Walkabout Transfer can be connected only to one dicta-
tion machine. If a 2nd dictation machine is connected to
the USB interface, this is not recognized by the PC, that is,
only one removeable disk drive appears under Windows. 

COMMUNICATION WITH THE PC____________________
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SOFTWARE INSTALLATION_____________________

Latest information
The latest information about the software is to be found in the
»README.TXT« file. 

Installing Walkabout Transfer 
1 Insert the programme CD into the CD drive.

– The window »Walkabout Transfer Setup« pops up.  

2 Follow the on-screen dialogue (»Select dialogue lan-
guage«, »Welcome« and »Licence Agreement«). 

3 Enter the serial number of your machine. This is to be
found in the battery compartment below the bar code.

4 Click on the »Next« button.

5 Follow the instructions given in the following windows
(»Information«, »Choose Destination Location«,
»Select Program Folder« and »Settings«).  
– The software is loaded. 
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6 Click in the window »InstallShield Wizard Complete«,
on the button »Finish«.

7 Launch the »Walkabout Transfer« program. 
– The »Walkabout Transfer« window opens up.

8 Connect the dictation machine via the USB interface with
the PC and switch it on.
– The dictation machine directory is shown. 

If the dictations stored on the card of the dictation machine
are shown, the installation was successful.

SOFTWARE-INSTALLATION____________________________
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Play
You can play the dictations stored in the dictation machine or
the PC.

1 Click on the desired dictation.

2 In the »File« menu, click on the »Play« command.
– You hear the dictation via the loudspeakers of the PC.

Or double-click on the desired dictation in the »Dicta-
tions on dictation machine« or the »My dictations«
window.

The playback and positioning functions can be carried out
with the buttons in the small window located between the
dictation directories of »Walkabout Transfer«.

Play Info 
All Dictaphone dictation machines equipped with the Info
function mark the Info in order to play it separately of the 
dictation.

Click on the » « button.
– You hear the Info at the beginning of the dictation.

In order to hear further Infos, click repeatedly on the » «
button.

Reduce window 
You can reduce the »Walkabout Transfer« window to the
size of the playback window.

Click on the » « button.

To restore the original window size, click on the » « button
again.

WALKABOUT TRANSFER ________________________
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In the menu functions windows, all functions which can currently be
carried out are active. If there are dictations in the »My dictations«
directory, most functions are available. The currently active func-
tions can also be shown by clicking with the right mouse button on
a dictation.

Meaning of the symbols 
The most important functions can be carried out by clicking on
the corresponding symbol in the symbol bar. If you move the
mouse pointer on a symbol, its function will automatically be
displayed.

Keyboard shortcuts  
»Walkabout Transfer« offers the following keyboard
commands.

»Ctrl + C« Copy into clipboard
»Ctrl  + O« Open dictation and play it back 
»Ctrl  + S« Save dictation as ...
»Ctrl  + V« Insert from clipboard 
»F2« Rename dictation
»F5« Refresh 
»Del« Delete
»Ctrl  + Ins« Copy into clipboard 
»Shift + Ins« Insert from clipboard 
»Ctrl  + Tab« Switching to next directory

MENU FUNCTIONS ________________________________

Save dictation as
Move all 
to PC

Display 
help

Send dictation

Display accom-
panying note

Move selected
to PC 

Move selected to the 
dictation machine (MMC) 

Export
dictation 

Delete 
dictation
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The File menu
In the »File« menu you can select the following commands:
»Send to«, »Save as«, »Play«, »Delete«, »Import«,
»Export« and »Exit«. The »Close« function is only active
when the dictation is opened. 

Note: 
All Dictaphone dictation machines which are equipped
with the clock function provide the dictation files with a
time stamp. The date appears in the »Started« column of
the dictation directories.

Send to ...
You can send dictations as .DSS file from the »My Dicta-
tions« directory. Depending on the dictation, the recipient
is already assigned in the »Send dictation« dialogue box.
If you send several dictations at a time, no name is pre-
assigned. If you wish to enter a different recipient, over-
write the pre-assigned name or select another via menu.

1 Click on the de-
sired dictation.

2 Click on the
»Send« 
command in 
the »File« menu.
– The »Send 
dictation«
dialogue box
pops up.

3 Select a recipient or enter the desired e-mail address.

4 If desired, enter a subject.

5 Click on the »Include DSS player« box, if you wish to
include this software.

6 Click on the »OK« button.  

MENU FUNCTIONS _____________________________________
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Close
With the »Close« function, the dictation will be removed
from the player.

Save as ...
You can save (archive) dictations under a different name in
any directory as ».DSS« or ».WAV« file.

1 Click on the desired dictation.

2 Click on the »Save as« command in the »File« menu.
– The »Save as« window pops up.

3 Select the desired directory.

4 Select the desired file format.
– The default setting is ».DSS«, meaning that the format
is not changed.

5 Click on the »Save« button.

Play
You can play back the dictations via the loudspeakers of the
PC.

1 Click on the desired dictation.

2 Click on the »Play« command in the »File« menu,
or double-click on the dictation to open it.

You can control the playback functions via the buttons
below the Player. 

Note: 
To hear or open a new dictation, the player must be
cleared from dictations.

MENU FUNCTIONS _____________________________________
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Delete
You can delete one dictation or several dictations at a time.

1 Mark the dictations you want to delete.

2 Click on the »Delete« command in the »File« menu,
or on the »Delete button « in the symbol bar.

– A safety prompt appears.

3 Click on the »Yes« button.

Import  
You can import dictations from any directory into the »My
Dictations« directory. 

1 Click on the »My Dictations« directory.

2 Click on the »Import« command in the »File« menu.
– The »Open« window pops up. 

3 Select the desired directory and dictation.

4 Click on the »Open« button.  

Export  
You can export dictation from DSS format to different WAV
formats which e.g. are used for speech recognition.

Exit 
Click on the »Exit« command in the »File« menu.

– »Walkabout Transfer« is ended.

MENU FUNCTIONS _____________________________________
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The Edit Menu 
In the »Edit« menu, you can select the following menu items:
»Accompanying note«, »Copy«, »Paste«, »Rename«,
»Move all to PC«, »Move selected to PC« and »Move
selected to dictation maschine (MMC)«.  

Accompanying note 
You can display and change any accompanying note.

1 Click on the desired dictation.

2 In the »Edit«  menu, click on the »Accompanying note«
menu item.
– The »Accompanying note« window pops up.

3 Fill in your changes. 

4 Click on the »Save« button. 

Copy, Paste 
You can copy dictations from any directory and paste it in any
other directory.

1 Click on a dictation in the »Dictation on the dictation
maschine« window.

2 Click in the »Edit« menu on the »Copy« command.

3 Click on the »My Dictations« menu item.

4 In the »Edit« menu, click on the »Paste« command.

These functions can also be effected by drag-and-drop with
the mouse as known from Windows. 

MENU FUNCTIONS _____________________________________
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Rename
You can change any dictation name.

1 Click on the desired dictation.

2 In the »Edit« menu, click on the »Rename« command.

3 Enter a new name in the »Dictation name« box.

4 Press the Enter key. 

Copy and Move 
»Move all to PC«, »Move selected to PC« and »Move
selected to dictation maschine (MMC)«.

Using these functions you can transfer dictations between the
PC and the dictation machine.

1 Connect the dictation machine via the USB interface with
the PC.

2 Use the »ON/OFF« button to switch the dictation machine
on and in PC mode.

Note:
Disconnect the USB interface only via the task bar (from
Windows 2000) as otherwise the data transfer can be
incomplete.

Through the »Move« function the dictations are deleted in the
source directory.

1 Click on a dictation in the »Dictation on the dictation
maschine« window. 

MENU FUNCTIONS _____________________________________
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2 In the »Edit« menu, click on the »Move selected to PC«
command.
– The dictation is moved to the »My dictations« direc-

tory.

– During data transfer the red recording indicator is 
blinking.

This function can also be carried by drag-and-drop with the
mouse as known from Windows.

Note:
An interruption of the data transfer due to exhausted 
batteries destroys the dictations. We recommend therefore
to carry out the data transfer only with full batteries or
with the mains unit.

View
In the »View« menu you can refresh the view of your direc-
tories. You can activate or deactivate the Toolbar and the
Status bar. Via the »Next directory« or the keyboard com-
mand »Ctrl + Tab« you can display the next directory (e.g.
»Sent dictations«).

These functions are handled as known from Windows. 

Note:
Carry out the »Refresh« command, if the dictations on
the dictation machine are not shown although the dicta-
tion machine is connected with the PC and the PC mode
is switched on. If the view of the directories does not
change after having carried out an edit function (e.g.
»Copy«), press the »Refresh« key (»F5« on the PC
keyboard).  

MENU FUNCTIONS _____________________________________
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The Settings menu 
In the »Settings« menu, you can carry out the following
commands: »Dictation machine drive«, »PC dictation
directory« and »General Settings«.

Dictation machine drive 
If the dictation machine is connected via the USB cable with
the PC, it is handled like a removable disk drive.

1 Click on the »Dictation machine drive« menu item in
the »Settings« menu. 
– The »Select directory« window pops up. 

2 Click on the drive unit assigned to the dictation machine,
e.g. »Removable disk drive (G:)« and then on the
»OK« button.
– The dictation machine directory is shown. 

PC dictation directory 
The »PC dictation directory« menu item allows you to 
select a directory for saving your dictations.

1 Click on the »PC dictation directory« menu item in the
»Settings« menu. 
– The »Select directory« window pops up. 

2 Click on the directory in which you wish to save your dic-
tations, e.g. »C:\Dictations\My dictations«.

3 Click on the »OK« button.

MENU FUNCTIONS _____________________________________
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General Settings  
With the »General Settings« menu function, you can acti-
vate or deactivate the control buttons of the Player.

The default setting for the Info/Dictation sound signal is on.
With the general settings function, it can be switched off.

The volume level at fast forward and rewind can also be
changed with this function. The default setting is 50% and
double speed. Using the arrow keys, you can adjust the
volume from 1 to 100%, and the speed to 1 to 30 times the
normal speed.

This function provides you also with the additional possibility
to save the individual order of your dictations list. 

1 Activate/deactivate the function or select the new set-
tings using the arrow keys.

2 Confirm with »O.K.«.

Note:

The sound signal is only active if »Sound« is selected in
the general settings of your PC. 

MENU FUNCTIONS _____________________________________
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E-Mail configuration
Here you can define your preferred e-mail receipient and if
needed your e-mail account data.

MENU FUNCTIONS _____________________________________
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Update
If you click on the »Update Service« button, your are linked
with the Dictaphone Corporation Download Center in the
Internet. From there you can download current information
and software updates. 

The changes made in the »Settings«menu are retained until
they are changed again, even if »Walkabout Transfer« is
ended.

MENU FUNCTIONS _____________________________________
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Dictation types and Groups 
Under »Settings – General settings – Dictation types
and Groups« up to 10 different dictation types and groups
can be edited.

Edit new dictation types or groups in corresponding fields and
press to »Apply«.

Under »Configuration – Accompanying note« one of 
edited dictation types and groups can be selected and trans-
ferred into digital dictation machine.

MENU FUNCTIONS _____________________________________
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MENU FUNCTIONS _____________________________________

User  
Under »Settings – General settings – User« it is possible to
create transcribers and authors with related e-mail addresses.  

Within send dialogue these users are displayed in pull down
menues as e-mail recipients and cc recipients and can be 
selected directly. 

Only one author and one typist of created users can be trans-
ferred into digital dictation machine via standard accom-
panying note. These users are necessary to identify dictations.

Note:
The Default_DICT user cannot be modified or deleted. Both
identifications and user name will be loaded into digital
dictation machine. The dictation machine creates the be-
ginning of dictation name out of first 4 characters of iden-
tification. The application determines the complete user
name out of identification and displays the complete user
name within dictation directories.
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MENU FUNCTIONS _____________________________________

Under »My identification« the author or the typist can con-
figure their own identification and name. This name automa-
tically appears in the program below symbol of working
directory »My dictations«.

The identification will be used to authorize changes of name
and e-mail address. For example the private e-mail address
can be used to send dictations to the home office.

The Help menu 
In the »Help« menu, you can select the following menu items:
»Help to Walkabout Transfer«, »Help to dictation
machine« and »Info about Walkabout Transfer«.  

These functions are handled as known from Windows.  
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Configuration  
Run the »Walkabout Transfer« program.

Click on the »Configuration« icon to call up the »Accom-
panying note«, the »Update Server« and the »Dictation
machine« functions.

If you click on the »Update Service« button, your are linked
with the Dictaphone Corporation Download Center in the
Internet. From there you can download current information
and software updates.

It is not necessary to connect the dictation machine for this
function.

CONFIGURATION __________________________________

Walkabout5210_lang-GB_1102  26.11.2002  9:17 Uhr  Seite 43



44

For the following functions, the dictation machine must be
connected.

If you click on the »Accompanying note« button, you can
change the settings of the accompanying note in the dicta-
tion machine.

If you click on the »Dictation machine« button, information
about the current configuration of your dictation machine is
displayed. Your authorized dealer needs possibly this infor-
mation in the event of service.

CONFIGURATION_______________________________________
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WARRANTY, SERVICE, SALES _________________

Please contact your supplier if you wish to register the guarantee of
this product or make a claim.

If there is no specialized dealer in your region, please contact the
following address.

Dictaphone European Headquarters  
VoiceCom AG
Ifangstrasse 91
8153 Rümlang
Switzerland
Tel. +41 (0)1 817 76 76

Dictaphone International Headquarters
Dictaphone UK Ltd
Commonwealth House
Chalk Hill Road, 
Hammersmith
W6 8DW  London 
United Kingdom
Tel: +44 (0)20 7878 5000 

Dictaphone World Headquarters
Dictaphone Corporation
3191 Broadbridge Avenue
Stratford, CT, 06614-2559
USA
voice.systems@dictaphone.com 
Tel: +1 203-381-7000
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Limited Hardware and Software Warranty 
Dictaphone Corporation warrants to the original consumer or other
end-user purchasers that this product is free from defects in mate-
rials or workmanship for a period of one (1) year for the hardware
and a period of 90 days for the software from the date of purchase.
During the warranty period, and upon proof of purchase, the pro-
duct will be repaired or replaced (with the same or similar model)
at our opinion, without charge for either parts or labor. This war-
ranty shall not apply if the product is modified, tampered with, mis-
used, or subjected to abnormal working conditions, (including, but
not limited to lightning and water damage).  

Repair or replacement as provided under this warranty is the exclu-
sive remedy of the purchaser. This warranty is in lieu of all other
warranties, express or implied, including any implied warranty of
merchantability or fitness for a particular use or purpose, and
Dictaphone shall in no event be liable to purchaser for indirect or
consequential damages of any kind or character. 

Some jurisdictions do not allow the exclusion or limitation of inci-
dental or consequential damages or allow limitations on how long
an implied warranty lasts, so the above limitations or exclusion
may not apply to you. This warranty gives you specific legal rights,
and you may also have other rights that vary from jurisdiction to
jurisdiction. 

This warranty applies to the United States only. All other countries,
please refer to your dealer’s warranty policy. 

WARRANTY FOR USA____________________________
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Walkabout Products – Support and Services 
Software and Operational Support 
Dictaphone shall provide at no-charge, product support by tele-
phone on the Walkabout products for a period of 90 days initiated
from the day of shipment to the customer. The no-charge period of
support assumes a PC with a functioning sound card and access to
the shared directory used to pass dictation to the software system.
It does not include the setup or support of other vendor’s products,
sound cards, mail programs, Internet access or networking issues. 

The Walkabout model and serial number is required to obtain the
initial 90 days of telephone support. The Walkabout serial number
is located either on the back or inside the battery compartment of
the product. Product support will be provided via a toll-free call. To
contact the initial 90-day-no-charge Walkabout Support Center in
the United States, dial (800) 677-7928.

Support after the first 90 days from the date of shipment will be pro-
vided on a per minute charge basis unless an Assured Performance
Plan (APP) contract is purchased. 

This support applies to the United States only. All other countries,
please refer to your dealer’s support policy. 

SUPPORT FOR USA________________________________
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Visit Dictaphone Corporation on the Web at: 
               www.dictaphone.com 

L-2765-001

WALKABOUT 5210 User Guide__________
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